


I remember Daddy told me: “Fairy tales can come true
You gotta make ‘em happen, it all depends on you”

So I work real hard each and every day
Now things for sure are going my way

Just doing what I do
Look out boys, I’m coming through!

~ Tiana, Disney's Princess and the Frog
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Biography Filmography
I am a texturing/surfacing and lighting artist who has been 
inspired by the CG industry and seek to become a creative 
and innovative artist who is able to contribute in the 
creation of riveting and alluring stories.

As a technical artist, and having worked on multiple 
animated	short	films,	I	have	a	solid	foundation	in	surfacing,	
lighting, rendering, and compositing, as well as experience 
working with a full production pipeline. On my teams, I am a 
strong and valued artist who, not only delivers quality work 
and	meets	deadlines,	is	also	detail	oriented,	flexible,	and	has	
strong communication skills.

With	a	background	in	fine	arts	and	experience	in	design,	I	
have developed an eye for analyzing the surrounding world 
and to use critical thinking to deconstruct visual elements. 
Drawing from this, I use a more contemporary skill set to 
work	and	demonstrate	proficiency	in	various	CG	tools.	I	am	
well versed in lighting, look development, rendering, and 
have experience in programming languages. I am not only 
able to artistically meet the necessary visuals, but also able 
to troubleshoot and develop solutions to issues to support 
the	efficiency	of	the	pipeline.

I like tigers.

CTN 2014 with Kirk Thatcher and Tori Davis



Resume
Work Experience
VFX Artist
Freelance (StudioX)                                                              September 2012 - Current                                                                             San Francisco, CA
• Lead artist management over team of junior artists
• Incorporate feedback from director(s) to follow direction
• Troubleshoot technical issues
• Review and feedback of work
• Management and documentation of assets

Resource Coordinator
Tea Time Animation                                                             September 2013 - Current                                                                             San Francisco, CA
• Writer of Tea Time Animation blog
• Management of assets (rigs and models) and tutorials
• Social media management

GDC Conference Associate
International Game Developers Association                2015                                                                                                                      San Francisco, CA

Exhibition Floor Lead
CTN Animation Expo                                                            2013 - 2014                                                                                                                    Burbank, CA
• Management of Booth Buddy volunteers    
• Resolution of questions and concerns

GameSage
Aeria Games Entertainment                                              2011 - 2013                                                                                                           San Francisco, CA
• Community and technical support
• Chinese to English translations of upcoming content from native versions of games
• Test and feedback of games

Facial Expressions Research 
University of Washington                                             January 2012 - August 2012                                                                                           Seattle, WA
•	Research	of	perceived	facial	expressions	on	3D	modeled	head	and	the	application	of	expressions	both	across	different	models	
and projected onto inanimate objects

Web Management
University Book Store - UDistrict                               June 2010 - July 2012                                                                                                        Seattle, WA
• Product photography for online store
• Creation of informational pages for various departments
• Conceptualize and create banners and button ads • R&D functional intranet

Graphic and Web Design                                          
Freelance                                                                            2008 - 2011                                                                                                                    Vancouver, WA
• Developed logos for clients • Designed functional and appealing websites for clients
• Logo design, website layout design, and English editor for SunningNet

Web Management
SimplexMFG                                                                      2008 - 2009                                                                                                                       Portland, OR
• Maintained and updated the website of www.simplexmfg.com
• Maintained and updated the database of information to go on the website.
•	Worked	in	a	project	oriented	setting	with	defined	deadlines

Skillset
Maya	|	Mudbox	|	Mari	|	ZBrush	|	Photoshop	|	After	Effects	|	Nuke	|	Vue	|	xGen
Mental Ray | VRay | Renderman | Caustic Visualizer
OSL | Java | English | Chinese (Mandarin)
Linux | Windows

Interests
Painting | Zoology | Ethology | Graphic Design | Web Design



Education
Academy of Art University
MFA,	Animation	+	Visual	Effects	(Lighting	and	Texturing)
2012 – 2015
President’s Honor List
2014 Spring Show VFX Feature Lighting 1st Place

University of Washington
Bachelor of Arts (BA), Painting and Drawing
2008 – 2012
GPA: 3.56
Dean’s List

Class List
2012 Fall

GLA 622 - History & Techniques of VFX
ANM 604 - VFX: Cinematography
ANM 629 - Fundamentals of Texture & Lighting

2013 Spring
GLA 621 - History & Techniques of Character Animation
ANM 630 - Node Based Compositing
ANM 633 - Character Design & Drawing for Animation
ANM 640 - Advanced Texture & Lighting

2013 Fall
ANM 670 - Preproduction
ANM 695 - Collaborative Project: CG Texture & Lighting
ANM 699 - 3D Texture Painting

2014 Spring
GLA 670 - Professional Practices: Animation, VFX, & Games
ANM 695 - Collaborative Project: CG Texture & Lighting
ANM 800 - Collaborative Project: Compositing

2014 Fall
GLA 623 - History & Techniques of Games
ANM 695 - Collaborative Project: CG Texture & Lighting
ANM 800 - Renderman
ANM 801 - Group Directed Study: Texture & Lighting

2015 Spring
ANM 695 - Collaborative Project: CG Texture & Lighting
ANM 800 - Environment Creation
ANM 800 - Collaborative Project: VFX 3D
ANM 801 - Group Directed Study: Texture & Lighting



FILMS

Abstract
To work on multiple collaborative projects as a texture artist and/or lighting artist with an active lead role covering a variety 
of genres and styles in order to develop a strong reel with quality shots and their breakdowns along with documentation and 
white papers of the process and certain technical resolutions of the shows.
As a lead I will be assisting with resolving technical issues, reviewing dailies, and be involved in the discussion of artistic 
direction. I will communicate with the producer and/or director about the vision and deadlines, necessities of the artists, and 
assisting in maintaining an organized pipeline to ensure the completion of the project that is polished to meet the needs and 
vision of the director.

I will seek to be involved in approximately three projects each semester, from the available production classes and others 
independent	films/theses	are	not	going	through	a	class.

To	demonstrate	execution	of	the	defined	responsibilities	of	a	lead	artist,	I	will	submit	the	following	upon	my	final	review:
 • Technical documentation occurred within my role(s) and solutions used to resolve the issue
 • Tutorials created to assist artists with certain technical aspects required of each project
 • Shot breakdowns for lighting and compositing
 • Texture and shader network and render pass breakdown for textured assets



SOAR
Our story begins with a young girl called Mara. A bright and optimistic 
thirteen-year-old, Mara dreams of one day becoming an airplane 
designer.	But	every	day,	she	test	flies	her	model	airplanes	in	the	fields	
behind her house, and every day, they crash.

One	day,	after	yet	another	unsuccessful	flying	attempt,	Mara	sits	
gloomily at a picnic table, trying to come up with new ideas. Suddenly, 
inspiration hits her on the head – literally. A tiny 5-inch-tall boy and his 
fantastical	flying	machine	drop	out	of	the	sky.

She	realizes	that	he	is	in	trouble:	his	flying	ship	is	broken,	and	the	rest	
of	his	fleet	is	leaving	without	him.	Now	Mara	must	use	every	ounce	of	
inspiration	she	has	to	fly	her	new	friend	back	home	–	before	it’s	too	late!

Directed by: Alyce Tzue
VFX Supervisor: Derek Flood

Role: Texture Artist, Lighting Lead, Compositor

Responsibilities:
• Texturing	of	fleet	ship	asset
• R&D surfacing of star asset
• Lighting series of shots
• Support of junior artists
• Troubleshoot rendering errors
• Creation and management of rendermatic
• Creation of CG elements for poster
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Fleet Ships Asset Shot 49
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Star Asset
refractive shell interior plane shatter planes VRay Sphere Light

Shot 51



Umbra (trailer)
The trailer for Umbra, a 3D Animated horror short, tells of a young boy’s journey into the forgotten depths where monsters lurk. 
Upon	his	wanderings	he	finds	a	light	and	a	young	girl	to	guide	him	but	everything	is	not	what	it	seems.

Directed by: Cal Williams

Role: Lighting TD, Compositing TD

Responsibilities:
• Completion of ten shot trailer for 2013 Fall Festival
• Creation of environment lights to be used across all shots
• Conversion of Mental Ray materials to VRay materials
• Troubleshoot geo cache and alembic cache issues
• Creation of Nuke script template to be used across all shots

Winner of 2014 Spring Show - VFX Feature Lighting
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Crows
There is a man, who is mysterious, sad, lonely, dark, emotionless, walking with a black cape-like coat on him. The city looks blue-
grey, cold and foggy, and it is early in the morning. He walks in the city, while he is walking, he collects all the blackness in the 
places	that	he	passes	by.	Blackness	comes	out	of	the	dark	parts	of	the	cityscape/landscape	and	fills	in	the	cape	of	our	man.	It	
looks like he is a magnet of the blackness; he calls it to come to him and blackness comes together under his cape. He opens his 
arms and turns the blackness that he collected into crows.

“Crows”	is	a	Visual	Effects	thesis	project	in	the	field	of	compositing,	owned	by	Ilgı	Çandar.	The	project	is	a	combination	of	CG	
models, real footage recorded by a HD Camera, some particle animation and matte paintings. It is inspired from a song of a 
Turkish band, and the song shares the same name with the project.

Directed by: Ilgi Candar
Producer: David Bober

Role: Surfacing Artist, Lighter

Responsibilities:
• Surfacing of crystal fragments
• Surfacing and look dev of crystaline crow
• Match lighting of crystaline crow in shot



Trailer Shot 01 Crystals Asset
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Curpigeon
A 3D animated short about a community of widowed men and their faithful park 
pigeons, who come together to help one of their own get through a great loss.

Directed by: Dmitry Milkin

Role: Character Texture Artist, Lighting Artist, Compositor

Responsiblities:
• Texture and surfacing of characters Tom and Longbeak
• R&D	of	surfacing	and	rendering	workflow	with	Caustic	Visualizer	render	engine
• Lighting and compositing of a shot



Tom Longbeak
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Muscle Beach
As Marvin, a short dorky guy, sets his sights on charming a beautiful lady he sees at the beach, his attempts become thwarted 
upon the arrival of a giant muscular hunk. However all is not as it seems as beauty is only skin deep and what is inside that 
counts.

Directed by: Corey Rosen

Role: Look Development Lead

Responsibilities:
• Texture and surfacing of characters, props, and environment
• Asset management
• Environment layout
• Scene	file	setup
• R&D of hair
• Sand and water R&D



Beach Env Bollard



Hank



The Architect
When Mr. and Mrs. Stone set out to build their dream house, they enlist 
the services of Miles Moss, a visionary modernist architect, whose 
soaring ideas are matched only by his ego.

Directed by: Jonathan Parker

Role: CG Lead, Lighter

Responsibilities:
• Lighting and render of CG assets to be passed to compositors
• Look development of house interior
• Troubleshoot render errors
• R&D of CG house
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The Snake & The Fox
This four minutes animation short will tell the story of how a tender hearted 
snake, that couldn’t kill but prefers to be alone, becomes friend with the 
curious lost innocent little fox.

Directed by: Moe Myint Htet

Role: Lighting Artist, Compositor

Responsibilities:
• Sequence lead
• Lighting and compositing of ending sequence consisting of 5 shots
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Aria for a Cow
Aria for a Cow is an animated musical short based on a previously unreleased 
song by the Oscar winning team of Howard Ashman and Alan Menken 
(“Little Shop of Horrors”, “Little Mermaid”, “Beauty and the Beast”, 
“Aladdin”).

When a callow young farmer shows himself to be completely uninterested 
in the sensitive art of milking a dairy cow, Aria, a bovine diva, along with 
her singing and dancing back up bulls, belts out a tune demanding to be 
respected for more than just dairy products. In the end, our young farmer 
learns	to	respect	the	collaborative	effort	that	made	Krelborn	farms	and	its	
cows an award-winning dairy farm.

Directed by: Dan Lund
Producer: Connie Thompson
Art Director: Amos Sussigan

Role: Lighting TD, Compositor, Texture Artist

Responsibilities:
• Lighting and compositing of shots
• Troubleshoot caching errors
• Troubleshoot render errors
• Creation of Nuke template for dailies review
• Texture	fixes
• Texture and surfacing of mobile asset
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Ruslan and Ludmila
Ruslan and Ludmila are separated on their royal wedding night when the evil 
Wizard Chernomor abducts the princess. They must overcome the perils of 
the mysterious lands surrounding ancient Kiev if they are to return to one 
another.

This project is the short adaptation of Alexander Pushkin’s famous epic poem, 
Ruslan and Ludmila. The goal is to create an interactive story experience for 
the	iPad.	The	production	and	pipeline	are	running	as	that	of	a	short	film	and	
in tandem with the app development pipeline. The app experience itself is 
a unique combination of high end CG animation, stylized illustration, and 
interactivity in a digital storybook format that recants the colossal adventure 
for a young audience.

Directed by: Miranda Middlewood
Executive	Producer:	George	Paftnutieff
Producer: Frank-Joseph Frelier

Role: Look Dev Lead, Lighting Lead

Responsibilties:
• Texture and surfacing of environment and character assets
• R&D look development
• Lighting and compositing
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Dino Hunt
Dino	Hunt	is	a	VFX	short	film	about	a	prehistoric	story	of	survival	between	a	herd	of	styracosaurus	and	pack	of	raptors.

Directed by: Amrinder Jassar & Lauren Kvalheim 
Producer: Frank-Joseph Frelier

Role: Texture Artist, Lighter

Responsibilities:
• Texture and surfacing of character assets
• Lighting and redering of CG elements to be composited



Goliath
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Knob
The story is about a neat freak who goes to an interview and gets stuck in a dirty restroom and the door knob is touched by a 
diarrhea	guy	without	washing	his	hands.	Furthermore,	the	restroom	is	out	of	paper	towel	and	soap.	He	tries	to	find	a	way	to	get	
out there as quickly as possible so as to catch up the interview.

Directed by: Hans Tsai
VFX Supervisor: Derek Flood

Role: Texture Lead, Lighting Lead

Responsibilities:
• Asset management
• Texture and surfacing of assets
• Lighting of shots
• Environment setup
• Support of junior artists
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Wishing Box
A story between a greedy pirate and his silly monkey. 
After	many	years	of	navigation,	the	pirate	finally	finds	a	
treasure box, but when he opens the box there is nothing in it. 
The	pirate	feels	very	upset.	However,	the	hungry	monkey	finds	
out the secret of this box; this box is a magical Wishing Box. 
The innocent monkey is able to take out anything he wants 
from the box. The greedy pirate detects this and asks the 
monkey to bring him treasures; all the silly monkey brought 
out of the box are fruits he wants to eat. Finally, the monkey 
seems to understand what the pirate needs and the brings out 
gold from the box. The pirate keeps asking for more and in the 
end they have so much gold that their ship cannot take it and 
sinks into the ocean. The pirate loses everything, even his gold 
tooth, but the monkey gets to eat his fruit! 

Directed by: Lizzie Zhang & Nan Li
VFX Supervisor: Derek Flood

Role: Texture Lead, Lighting Lead

Responsibilities:
• Asset management
• Texture and surfacing of assets
• Environment	file	setup
• Color LUT creation
• Support of junior artists
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Tutorials



Creating an Ocean with VRay Water
Creating a full ocean can be a daunting task, especially if you are not well versed in dynamics. Even then, creating the water is 
only half the problem as rendering also needs to be taken into consideration. Let’s try to keep things in what we can do in Maya; 
Houdini is out of the question. Maya does have decent ocean presets but unfortunately they do not render well or at all with 
VRay. Thus we look at VRay Water.

VRay Water is a procedural displacement texture used to simulate a water surface. As it displaces the water surface, your 
geometry should be a polygon plane.

To	enable	displacement	in	VRay,	first	go	to	the	Shape	tab	of	your	polygon	plane	in	
the Attribute Editor and under Attributes > VRay enable Subdivision, Subdivision and 
Displacement Quality, and Displacement Control. For your basic displacement settings, 
make sure that Render as Subdivision Surface and Keep Continuity are both checked 
while Subdivide UVs is unchecked. The most important part is to set the Displacement 
Type to Vector Displacement as that is what the VRayWater node creates. Other types 
of displacement will not work with the VRayWater node.

After	creating	the	VRayWater	node,	connect	it	to	the	Displacement	mat.	field	of	the	
material that is assigned to your ocean plane.



To	create	your	ocean	surface,	in	the	VRayWater	node	is	where	you	will	find	your	settings.	All	the	attributes	can	have	keys	set	on	
them to create moving water in animated sequences.

•Height Multiplier – scale multiplier for the whole texture
•Wind	Direction	–	specifies	the	wind	direction	/	the	direction	of	the	waves
•Wind	Magnitude	–	specifies	the	strength	of	the	wind	creating	the	waves.	Higher	
values creates larger waves.
•Wind Direction Multiplier – multiplier for the importance of the wind direction. 
Smaller values will produce more variation in the direction of the waves
•Choppy Multiplier – a multiplier for the choppiness of the waves. Higher values will 
produce sharper look waves.
•Rate	–	Speeds	up	or	slows	down	the	movement	of	the	waves	(only	has	effect	in	
animation).
•Seed – used to set the starting point for the random generator
•Resolution – amount of detail in the generated map
•Patch	Size	–	specifies	the	real	world	size	of	one	patch	of	the	VRayWater	texture	
whereupon outside is perfectly periodic
The	height	of	the	waves	can	be	changed	in	a	few	different	places	if	you	have	noticed.	
There is the height multiplier in the VRayWater node but also the Displacement 

Amount	in	the	displacement	attributes.	It	is	recommended	that	you	first	focus	on	the	height	multiplier	in	the	VRayWater	and	
thus all your water surface settings are all together. Only use the Displacement Amount attribute in addition if you feel the 
necessity to further decrease the wave height past the lowest amount (0.001).

If	you	find	that	there	are	holes	in	your	water	surface	in	the	render	that	is	because	the	displacement	is	extending	past	the	
bounding box. To resolve this issues, in the displacement settings, located Displacement Bounds and change the setting to 
Explicit.	In	the	Min	Value,	manually	type	in	a	negative	number	in	the	Value	field	to	further	lower	the	bounding	box	to	encompass	
the displacement amount of your water surface.

 If you are creating a large open body of water with the camera at 
a respectable distance away, with a good VRayMtl that contains 
specular	and	reflections	that	interacts	properly	with	light,	this	may	
be as far as you need to go. You do not necessarily need to create 
a refractive water material as it would become necessary and only 
increase render time.

However, in the following case, the water is lapping up against a beach and we will need to go a step further. First, to create a 
refractive water material the Refraction Color is turned up to white, the IOR is set to 1.33, and the Fog Color is set to a very slight 
blue.



Next	up	is	to	create	some	sea	foam.	The	first	area	where	we	want	to	create	the	foam	is	against	
the	edge	of	the	water;	where	the	water	and	the	beach	meets.	To	isolate	that	specific	area,	
occlusion through the VRayDirt material is used to generate a black and white mask. The 
occluded color should be white and the unoccluded color needs to be black. Make sure to check 
Invert Normal	so	that	the	beach	geometry	is	able	to	influence	the	occlusion	back	onto	the	water	
plane. I have additionally connected a Noise node into the occluded color to break up the edge 
and not just a smooth border along the edge. In an animated sequence, you will want to bake 
the occlusion in an image sequence to save render time instead of having Maya recalculate the 

occlusion every single frame.

The other area where the foam would want to be created is along the crests of waves. Since VRayWater is actually displacing the 
geometry, the VRayDistance node can be used to create a mask to isolate the tops of waves. Upon creating the VRayDistance 
node, the geometry upon which the calculations will be done upon needs to be added into the distTex_set through the Set 
Editor. In the VRayDistance settings, set the Far Color to black and the Near Color to white. The Inside Color and Outside 
Color	can	be	enabled	and	set	to	a	dark	gray	to	create	fall	off	between	the	near	and	far	colors.	Adjust	the	Distance	attribute	to	
isolate as must or as little of the crest 
of the waves that you want. If you are 
testing the mask on a separate material 
temporarily, remember to connect 
your VRayWater displacement to your 
material so that the VRayDistance node 
has something to read.

For the foam material, a slightly refractive white VRayMtl was used with a Noise node connected to the bump to simulate the 
effect	of	looking	like	little	bubbles.	However,	the	shadows	were	very	dark	as	a	result	and	foam	has	a	very	light	and	translucent	
look to it; thus, the normal refractive VRayMtl was blended together with a VRayFastSSS.

Connect everything together with a VRayBlend. The water would be the base material while the foam will be the coat material 
with the two masks that were created connected in the Blend Amount. If a VRayBlend was not used since the beginning, 
remember to reconnect the VRayWater into the Displacement mat. of your VRayBlend material.





Troubleshooting Flicker in VRay
One	of	the	more	agonizing	things	about	being	a	lighter	is	finishing	a	shot	to	render	but	getting	back	files	that	are	unusable	due	
to	unaesthetic	flicker.	While	the	flicker	can	be	fixed	by	increasing	render	settings	globally,	that	method	comes	at	the	cost	of	
increased	render	times.	Instead,	narrow	down	where	the	flicker	is	coming	from	and	solve	the	issue	at	the	root	instead	of	trying	
to “throw more money at the screen and hope for the best”.

It is extremely important to render in passes so that not only will you have control over every single aspect in comp but it breaks 
the render down into its elements for trouble shooting.

The	Pass	column	is	the	pass	that	you	want	to	check	if	the	flicker	is	coming	from.	The	material	column	is	the	source	of	the	flicker.	
The	Flicker	column	is	what	needs	to	be	changed	to	resolve	the	flicker.	If	the	flicker	seems	to	be	coming	from	the	lighting	pass,	
the	source	is	the	diffuse	of	the	material,	and	what	you	want	to	do	is	increase	the	light	rays	for	the	shadow.	If	the	flicker	is	in	the	
specular pass, increase the subdivisions of the light.

The	exception	to	the	above	is	hair.	Hair	shows	up	in	the	reflection	and	refraction	passes	but	the	VRayHairMtl	doesn’t	have	
subdiv	attributes	to	make	adjustments	on.	In	the	case	of	hair,	to	resolve	flicker,	what	instead	needs	to	be	done	is	increase	the	
subdivision/fine	tune	the	GI.	This	is	because	the	flicker	shows	up	in	the	refraction	pass	which	is	a	secondary	light	ray.	As	there	
are no refraction subdivision settings in the VRayHairMtl, the only other way to adjust the secondary light ray settings in this 
situation is to adjust the GI.



The	other	type	of	flicker	that	may	be	seen	is	what	is	known	as	“fireflies”.	Fireflies	appear	as	large	dots	of	light	and	are	most	
prominent	in	the	specular	and	reflection	passes.

As	of	VRay	3.0,	it	has	been	found	that	VRay	Sphere	Lights	tend	to	cause	fireflies	in	the	reflection	pass.	Disabling	“affect	
reflection”	of	the	light	does	not	solve	the	issue	and	neither	does	increasing	the	material’s	reflection	subdivision	amount.	If	this	
issue occurs, the solution is to go to the Render Settings, under the VRay tab, expand Global Options - Advanced and enable 
Clamp Max Ray Intensity and set the value to 1.0.



VRay Environment Overrides with HDRIs
HDRI	images	are	amazing	and	beautiful.	They’re	also	extremely	useful	for	texturing	and	lighting	as	reflections	work	off	of	
reflecting	things	in	the	environment.	It’s	hard	to	get	good	reflections	and	know	what	something	is	going	to	look	like	if	your	
object	exists	only	in	a	strange	gray	world.	This	is	particularly	necessary	to	match	reflections	on	objects	that	will	then	have	to	be	
composited into a live action plate.

HDRLabs.com is an amazing resources to get some hdri images from.

Upon	downloading	one	of	their	environments	you	will	get	a	zip	file	with	different	image	files.		There	may	be	files	such	as	an	.ibl	
file,	a	2k	.hdr	file,	a	bg	.jpg	file,	an	env	.hdr	file,	preview	.jpg,	and	a	thumb	.jpg.	Not	all	of	these	are	necessarily	used	as	some	are	
for imaged based lighting but for now I am just talking about using the images to create an environment for whatever assets is 
being rendered.

In Maya, go to the render settings, and under the VRay tab there will be an Environment section which can be expanded out. 
Turn	it	on	first	with	the	checkbox	“Override	Environment”	The	largest	file	in	dimension	size,	usually	a	.jpg	file	will	connect	into	
Background	Texture.	The	medium	sized	high	quality	file	will	connect	into	Reflection	Texture	and	Refraction	Texture	The	smallest	
file	in	dimension	size	and	blurred	image	file	will	connect	into	the	GI	Texture



Intricacies of xGen in Maya 2015 - Hair Edition
These are some of the issues that I have found while working with xGen to create hair in Maya 2015. Using xGen for creating 
environment	has	a	whole	slew	of	different	issues	that	I	have	experienced.	Special thanks to Ashlee Martino-Tarr for breaking everything 
she touches.

xGen will not work properly for Vray if you only have the xGen Vray plugins loaded in your plugin manager. Make sure that xGen 
for Mental Ray is also loaded along with the xGen tool kit. It is important to note, that you may have all the usability of Xgen but 
when rendering, the hair may not show up.

Make	sure	you	have	all	of	your	xGen	plugins	loaded	into	your	scene	file	before	opening	a	scene	with	xGen	guides/	materials	or	
creating xGen guides. If you do not, xGen will not work properly when rendering. If you realize you started working on a scene 
without having all the scripts loaded, autoload them in the Plugin Manager, save your scene and completely close out of Maya. 
xGen will not work properly/will not render if you try to add needed plugins after starting xGen guides. In some cases the load 
boxes may be grayed out; xGen needs to refresh which is why you must exit Maya completely and restart it.

When creating your xGen Collection and Description, make sure that they have 
unique names. If the name clashes with something else in your outliner, xGen will 
still	allow	the	collection	to	be	made	but	when	attempting	to	save	your	scene	file,	the	
necessary	.xgen	file	will	not	be	generated	and	thus	your	work	will	not	be	saved.

xGen does not work with references.



You may see an error, something along the lines of 
// Error: XGen:  Error in expression “beard1::length”. [$a=1.0000;#0.05,5.0]

Error: Unexpected end of expression’:
    $a=1.0000;#0.05,5.0

For whatever reason, sometimes the expression is incomplete. The expression is missing a 
second line with $a. If you look in either the script editor or the xGen log, it will say exactly 
which	field	has	the	error	in	its	expression	that	needs	to	be	fixed.

When	painting	pTex	maps	for	defining	masks,	it	is	optimal	to	assign	a	lambert	material	
to	the	geometry	first.	When	attempting	to	activate	the	live	paint,	Maya	tends	to	have	
issues with recognizing the surface to be painted on if the geometry has a material with 
miscellaneous attributes. 

After creating a region mask, change the Region Mask	value	to	1	to	enable	it.	0	means	that	the	mask	has	no	influence.

Painted	maps	are	not	only	stored	in	your	xGen	folder	but	also	in	a	3DPaint	Textures	folder.		When	passing	your	files	off	to	
someone else, make sure to include your most recent 3D paint texture folders otherwise xGen may load in out-dated info.

Sometimes when scrolling through the editor, the dropdown options may be accidentally changed. Make sure that the Output 
settings have Operations set to Render and Renderer to your render engine otherwise things will not show up in the render.

If your hair does not follow the guides in your render but appears to be correct in the viewport, reassign your shader to the hair 
and render again.

If	you	add	additional	guides	at	a	later	point	and	find	that	the	hair	is	not	following	the	guides	when	testing	on	a	turntable,	return	
back to frame 1 and convert the guides to curves and then back to guides again.

xGen cannot read movement of the Geo if its patch is being deformed inside a group. 
Ex: Your tiger has fur but the fur doesn’t follow because the actual tiger geo isn’t being rotated. Instead you have the tiger geo 
in a group and that group is being rotated. To xGen, this means that the patch isn’t moving/deforming. 
	 You	can	fix		this	by	:

A. Selecting the geo that the guides are connected to and key the geometry instead of the group it is contained in.
B. Pull geo out of the parent group and smooth bind it to a joint that will “deform the mesh”.

If using GI, make sure you uncheck use camera path , otherwise you will experience a lag time in which Maya becomes 
unresponsive before starting renders.



Quick and Basic Lighting & Rendering
Here	is	a	super	fast	way	for	animators	to	texture,	light,	and	render	shots	to	spruce	up	pieces	to	have	a	finished	quality	for	reels.	
What’s great about this method is that it can be as simple as you want or as complex as you want; like baking a cake you can 
have plain yellow cake made from a mix out of the box or you can continue to add sprinkles, frosting, and rum to it.

In	this	tutorial	I	will	be	using	Mental	Ray	and	in	Maya	2014	but	it	can	be	done	with	any	render	engine	and	across	different	
platforms	as	long	as	you	render	out	the	necessary	layers	of	at	least	the	diffuse	(color)	and	occlusion.

Creating the Diffuse Layer
To	start	off	with,	use	surface	shaders	for	everything.	Surface	shaders	are	
the	utmost	basic	shaders	that	are	just	flat	color.	Surface	shaders	do	not	
interact	with	lights	and	has	no	specular	or	reflections.	This	is	great	in	that	
you will not have to worry about making physically accurate materials and 
everything is just based on color. As there is no need for light information, 
when	rendering	the	color,	everything	comes	out	flat	but	extremely	fast;	a	
few seconds per frame.
To create shaders, go to the hypershade window through Window > 
Rendering Editors > Hypershade.

In the hypershade either 
find	the	Surface Shader 
in the list or type it in 
the search bar to bring it 
up. Click on the surfacer 
shader to create the 
shader.



In the Out Color	set	the	color	desired.	Do	this	for	each	different	item	in	your	
scene. It would be best to name all your surface shaders so you will be able to 
keep track of what everything is. 

Sometimes	you	want	a	bit	more	than	just	a	flat	color	on	an	object.	Again	in	the	
Out Color of the Surface Shader, click on the checker icon to the right which will 
bring up a Create Render Node window. Find the File option and click on it. Then 
in the Image Name	section,	browse	to	where	your	file	is	located.

To assign the shaders you can either middle mouse and drag the shader 
onto	the	mesh	or	select	the	mesh	first	and	then	right	click	on	the	surface	
shader which brings up a menu and then drag up to select Assign Material 
to Selection. I personally prefer the second method due to I know exactly 
what is being applied where and I don’t accidentally apply it to something 
else which may tend to happen with the drag and drop method.



Creating the Ambient Occlusion Layer
Since	the	surface	shaders	renders	everything	as	flat	colors	there	is	no	form	to	anything.	Occlusion	will	help	give	dimension	to	
everything when we composite it on top.
Occlusion is the shadows created by ambient light and occurs between the objects, such as corner of walls. Maya is able to 
create occlusion by using mathematical algorithms to calculate occlusion. As occlusion is created through calculations, this will 
take the longest to render.

To	do	so,	first	select	all	the	geometry	in	your	scene	and	create	a	new	render	layer	by	going	to	the	Render tab of the Channel 
Box/Layer Editor and pressing the Create New Layer and Assign Selected Objects button, that looks like a blue circle and an 
orange star on a white plane. This will automatically create a new render layer and put everything selected in it. The button 
beside it, without the blue ball, just creates an empty render layer. If you press that one you can manually add geometry into it 
by right clicking on the layer and selecting Add Selected Objects.

Next, right click on the newly created layer and select 
Attributes. This should bring up the render layer 
attributes but Maya likes to give you a random tab 
at	times	the	first	time	you	do	it;	if	that	happens	just	
go back to the render layers and select the attributes 
selection again. In the renderLayer attributes, click on 
the Presets button and select the Occlusion option.

This will automatically create a surface shader with an occlusion node attached 
and assigned to everything in the layer. Either click on the square with the triangle 
on the right of the Out Color or click on the mib_amb_occlusion1 tab up top to 
view your occlusion settings. If the occlusion is looking extremely grainy in the 
render increase the Samples attribute. Increasing the samples will increase the 
render time so make sure you only raise it if necessary and only as high as it needs 
to	be.	Do	not	arbitrarily	start	off	with	something	ridiculous	such	as	50000.



As occlusion is calculated based on object to object, it becomes important that the 
objects in the scene are clean otherwise you may get some awkward shadows and edges.

Creating a Lighting Layer
This is optional. Going back to the cake reference, this is the sprinkles that you can add on top if you want it. Sometimes you 
may	have	a	very	specific	light	source	that	is	visible	in	the	scenes	and	you	want	it	to	cast	a	strong	light.

Again,	create	a	new	render	layer.	We	will	be	using	the	rendered	image	to	be	multiplied	on	top	of	the	diffuse	and	occlusion	
composite	thus	we	want	everything	to	start	off	as	gray.	Right	click	on	the	render	layer	created	and	select	Overrides > Create 
New Material Override > Lambert.



Now	place	lights	where	you	want	them.	As	this	layer	uses	the	very	basic	lambert	material	and	just	a	few	lights	to	define	certain	
areas,	this	will	render	decently	fast	also.	The	first	six	yellow	icons	are	the	lights.

Spotlight
As it sounds, this light acts like a spotlight. It emits light from a single point and emanates out in a cone shape. The Cone Angle is 
how wide the spotlight is and the Penumbra Angle	will	modify	the	falloff	edge	of	the	light.
With a shade on the ceiling light, it would be nice to have volumetric lighting. To do so, under the Light Effects there is a Light 
Fog attribute. Click on the checkerbox to the right and a lightFog node will be created.



Point Light
Point	lights	radiate	light	in	all	directions	from	a	single	point.	Good	to	use	to	cast	light	to	fill	in	areas.
Here I have the Decay Rate set to Quadratic.	Decay	rate	is	how	far	the	light	can	travel	before	it	fades	off	and	quadratic	is	the	
mathematical	calculation.	I	want	the	point	light	to	have	a	soft	fade	off	instead	of	having	the	light	travel	on	infinitely	and	light	
everything.
For Shadows you want to use Use Ray Trace Shadows. The Light Radius attribute will determine how soft the shadows are. The 
shadows may be grainy due to the lack of light rays and thus the Shadow Rays attribute may need to be increased.

Directional Light
Directional lights shoot rays parallel in the same direction. Technically lights all radiate from a single point outward but is good 
to emulate lights such as the sun where the light source is so far away that the light rays are basically parallel. This light does not 
matter where it is placed or how large it is, the only important information is the orientation of the light.



Rendering
Before	rendering	the	full	shot,	it’s	good	to	check	how	things	look	first.	In	the	upper	right	of	the	toolbar	are	the	render	options.

The	first	button	is	Open Render View, the second is Render the 
Current Frame, and the fourth button is Display Render Settings 
Window.	Click	on	that	first	button	to	bring	up	the	renderview	
window.	In	the	renderview	window	a	few	things	to	do	first,	set	the	
rendering engine to mental ray in the drop down, in Options > Test 
Resolution turn the resolution down to something like 50% so that 
the tests render faster, and then set the camera that you want to 
render from under Render > Render.	The	very	first	button	under	File 
is the button you click to begin the render.

Once	everything	looks	good,	it’s	time	to	send	things	off	to	render!	Set	your	project	first	so	that	Maya	
knows	where	to	save	the	files.	Go	to	File > Set Project and choose the folder where you want to render 
to.

If	you	don’t	have	a	project	directory	set	up,	Maya	will	bring	up	a	dialogue	box	saying	that	it	can’t	find	a	
project	definition	file.	Press	the	Create Default Workspace option and Maya will automatically create a 
workspace.mel	file	in	the	folder	while	will	generate	necessary	folders.	By	default,	the	rendered	images	
will go into a folder named “images”.

In the render tab of the channel box/layer editor the icons on the left will indicate if the 
layer will be rendered or not. If the layer has a green checkmark it will be rendered; if 
the layer has a red X it will not be rendered. Turn on the layers you want to render.
Click on the Display Render Settings Window to bring up the render settings. Set 
the Render Using dropdown to Mental Ray. Set the File Output to PNG. Set Frame/
Animation Ext to name.#.ext. Set the Frame Range to the frame range of your 
animation. Set the Renderable Camera. Set the Image Size. Everything else should be 
fine	as	it	is	on	default.

To batch render, in the Rendering menu set, go to Render > Batch Render. This will take 
awhile, particularly with the occlusion layer so take a break and socialize with some 
people,	have	some	coffee,	go	exercise,	and/or	have	some	ice	cream.



Compositing
We’ll	go	to	After	Effects	for	compositing	as	it	is	more	widely	known	
and	accessible	to	people.	Import	in	the	diffuse	renders	and	the	
occlusion renders. Create a new composition quickly by dragging 
the	diffuse	and	occlusion	down	into	the	timeline.	Make	sure	the	
occlusion	is	on	top	of	the	diffuse.	If	you	do	not	see	a	mode	option,	at	
the bottom there is a Toggle Switches / Modes option to make the 
modes visible. On the occlusion layer, set the mode to Multiply.

Done. You know have dimension and form and some simple 
shadows.

To get the light layer into the composite, do the same by placing it on top and set the mode to multiply.



Talks From 
Industry Professionals



Mike Midlock - The Journey
February 15th, 2013

Mike knew that he wanted to go into animation since a very young age; he was taught how to draw cartoons by his grandfather 
and	made	a	connection	of	cartoons	with	animated	films	that	Disney	was	producing.	Later	on	Star	Wars	came	and	Mike	
immediately fell in love with that and further kindled his passion. Unfortunately the art program at his high school was cut and 
so he went on to focus in graphic design during college. It was then that movies such as Who Framed Rodger Rabbit, The Little 
Mermaid, and Terminator 2 came out that he saw that the path was not closed and wanted to go back to animation. Thus Mike 
started the animation program at Sheridan University. 

Being in Chicago, Mike was later hired at Calabash as a traditional animator and he not only worked on commercials such as 
Lucky Charms and Trix,	but	was	also	given	the	opportunity	to	work	on	the	film	Space Jam. Later on, Mike felt the need to move 
on from cereal commercials and feeling that one of the best ways to get breaks is to be where the action is. Unfortunately 
back then, there were only a few small studios in Chicago so Mike made the decision and moved to California  to worked at 
MondoMedia, then transitioning to work on various The Sims games at Maxis, and then eventually Mike was hired at LucasArts 
to work on Indiana Jones and Star Wars games. After awhile, Mike realized that while he liked games, he was not a gamer and 
wanted	to	get	more	out	of	animation.	Mike	started	looking	over	towards	ILM,	even	though	it	meant	having	to	give	up	his	staff	
position	and	the	benefits	and	become	a	contract	worker.	Mike	felt	stronger	that	he	needed	a	change	and	needed	to	take	the	
chance.	The	first	project	Mike	started	on	was	Rango and since then he has worked on Pirates of the Caribbean: On Stranger Tides, 
Super 8, The Avengers, and Pacific Rim.	Now	while	in-between	contracts	at	ILM	he	finds	freelance	work	and	teaches	character	
animation at the Academy of Art University.

Some	final	words	of	inspiration	that	Mike	gives	is	to	start	thinking	about	your	dream	job	and	tailor	your	path	and	work	towards	
it. Even while doing exercises and school work, start thinking about how to incorporate it as a portfolio work. For example, 
many animators want to go to Pixar. While it is important to show good animation, even more important is to show good acting. 
A really good example of such a case is dialogue. Find a piece of dialogue and portray the action in contradiction to the dialogue 
to	give	it	depth.	Another	very	good	recommendation	is	to	have	your	best	stuff	prepared	at	any	given	time.	Luck	is	what	happens	
when preparation meets opportunity. As the industry has grown, no longer cornered in California but has grown world wide, 
be	adaptable	and	flexible.	Be	willing	to	go	where	work	is	at	and	start	getting	experience.	Don’t	be	intimidated.	Get	out	of	your	
zone and meet people, show enthusiasm. Always be nice as the industry is actually pretty small and as people move around you 
will be working with them and creating connections.



Glen McIntosh - Monster Mash
November 6th, 2013

Glen	initially	majored	in	film	studies	and	then	went	on	to	study	traditional	animation	
at Sheridan College. He moved out to Ireland and started out at the Sullivan Bluth 
Studios	as	an	inbetweener	and	fix	animator	with	hand	drawn	animated	movies	such	as	
Thumbelina and Anastasia. During his time in Ireland was when Jurassic Park came out, 
which he fell in love with, and was inspired to traverse into the realm of 3D. Glen jumped 
from working on Anastasia,	a	2D	animated	film,	directly	onto	Star Wars I: The Phantom 
Menace. Glen mentioned he had no idea how to use a computer and so he jumped right 
in and started learning all the new technical aspects from the ground up. One of the 
largest hurdles Glen found in his transition from 2D to 3D was that 3D animation could 
not be cheated as much as in 2D animation. Traditional animation gives you a lot of 
leeway in poses. It’s easy to throw in a smear frame here or there, and poses could hide 

certain elements of animation (an arm behind the body is an arm you don’t have to worry about).  Meanwhile, in a 3D character, 
a	pose	has	to	look	good	from	every	angle.	If	poses	are	cheated	-	such	as	an	arm	intersecting	the	body	-	the	pose	may	look	fine	
from the view of the camera, but it may cause issues further down the pipeline during cloth/water simulations and lighting.

One of the things Glen is quite known for is his work as the raptor lead in Jurassic Park III. Despite his phenomenal work, Glen 
tells	us	that	he	was	pulled	off	of	Star	Wars	Episode	II	and	it	felt	terrible.	“At	the	time	we	were	seeing	all	of	these	amazing	
concepts for the arena and it sort of hurt to think that I wouldn’t get a chance to be a part of this incredible space-gladiator sort 
of	battle.”	In	the	end,	however,	he	was	satisfied	with	the	decision	as	it	lead	to	his	chance	to	take	on	a	larger	role.	“Being	a	lead	
of any sort wasn’t something I actively pursued, I was just really enthusiastic,” He tells us. “I happen to love dinosaurs more 
than anything.” It was simply nice to be able to be more immersed in something he was already so passionate about. One of the 
biggest perks about being a Directing Animator is the amount of time Glen gets to spend on set. He spent some time regaling us 
with stories about the set of Battleship and his brief time as both an ‘acting coach’ for Rihanna and a stunt double for...a stunt 
double.

When it comes to setting up a shot, Glen told us a bit about his animation process, particularly the importance of knowing the 
capabilities	of	your	rig.	Animators	need	rigs	to	do	specific	actions	which	the	rigger	may	not	always	to	take	into	account	so	by	
“doing	your	homework”	first	the	rig	can	be	kicked	back	to	rigger	and	changed.	The	next	step	is	blocking	out	the	animation	
and	while	different	people	may	have	different	definitions	of	what	blocking	means,	it	is	important	to	show	directors	only	the	
animation in which they will be critiquing. While it may look cool to turn on all the textures or use some cards to show splashes 
or explosions, it would be better to use simple geometry as placeholders for more straightforward evaluation.



Some suggestions that Glen has for animators is to not become pigeonholed into a single role. While working on animation, 
don’t just become the robot person or the dinosaur person. To broaden the spectrum of your work, try to break it up into 
binaries such as male vs female, comedy vs dramatic, cartoony vs realistic, organic vs inorganic, etc. It is important to study 
the	world	around	you	and	see	the	little	differences	in	it	instead	of	assuming	what	you	know	and	filling	it	in	your	mind.	Glen	
told	a	story	about	an	intensive	figure	drawing	class	where	the	model	came	in	and	he	was	missing	a	thumb	but	people	were	
automatically	filling	it	in	their	mind	and	drawing	five	fingers	in	their	sketches.	When	looking	at	animal	reference	for	creatures,	
notice	how	animals	act	differently	than	humans.	Animals	are	reactionary,	they	don’t	stop	first	to	think	about	their	action;	there	
are inconsistencies and fast jerks in their actions instead of smooth and steady arcs. Don’t be afraid to act out reference and to 
feel the movement. Animators are actors so don’t worry about your ego, instead think about how your acting helps you achieve 
the most desired end result.

A fun question to end the night with is Glen’s three favorite movies that he would recommend everyone to watch. Jaws was the 
first	movie	that	came	to	mind.	While	there	were	inconsistency	issues	from	shot	to	shot	due	to	being	shot	on	the	wide	ocean	but	
due to the acting and music the movie still comes across beautifully and conveys its purpose. The two other movies weren’t any 
particular titles but Glen recommends anything from Stanley Kubrik, such as Full Metal Jacket, and Steven Spielberg, such as War 
of the Worlds, due to the beautiful photography and composition. Composition conveys meaning and Kubrik and Spielberg have 
fantastic strong compositions in their movies.



Rob Minkoff - The Process of Creating a Film 
February 22nd, 2014

Tea Time Animation hosted a fantastic evening with Lion King and Mr. Peabody and 
Sherman	director	Rob	Minkoff,	alongside	producers	Alex	Schwartz,	and	Denise	Cascino,	
to talk about what it was like revamping the Mr. Peabody and Sherman franchise into a 
modern	film.

Approach to creating story 
Rob, Alex, and Denise, really liked the idea of being able to go to multiple time periods and 
with	the	promise	of	what	animation	can	do	and	offer	and	they	really	wanted	to	showcase	
that ability. From there, how a movie starts and boils down to is the relationship of the 
characters with each other or to certain things or ideas. Start with a question and as the 
plot progresses, always return back to thinking what is the journey of the characters and 
their relationships and always old on to that core and how the story is told.

There weren’t any major issues from production and there was not a lot of pushback from 
fans, rather as so many people were also fans, everyone felt responsible to get the movie right.

Tiffany Ward’s contribution  
As	the	daughter	of	the	original	creator,	Jay	Ward,	Tiffany	was	described	as	the	“godmother	of	production”.	Not	only	being	the	
executive	producer	in	ensuring	the	movie	being	true	to	the	original,	Tiffany	made	sure	everyone	was	motivated	and	excited	
about	creating	the	film.

Ty Burrell as Peabody’s voice actor
Since	Mr.	Peabody	is	already	an	existing	character,	when	finding	a	new	voice	actor	to	play	Mr.	Peabody,	a	particular	type	
of voice and acting is required. A mimic isn’t good enough as sounding alike doesn’t quite go the distance. Instead, life and 
character needs to be given and instead of just an impersonation. Initially, Steven Colbert and Robert Downey Jr. were 
considered. Steven Colbert loved Mr. Peabody and Sherman and said he would love to voice any character in the movie except 
Mr. Peabody as unfortunately he did not time in his schedule to play the main character. RDJ was unfortunately busy making 
Avengers. Ty Burrell was brought in and after working with him for a couple weeks the voice of Mr. Peabody was found!

Development of the bullying scene
The bullying scene is really dark and serious. Even more so now as bullying is an important issue that is occurring in schools 



today.	When	the	scene	was	first	scripted	there	was	some	pushback	saying	that	it	was	too	dark	and	negative	but	after	discussion,	
everyone felt and decided that they were on the right side of the issue. A great quote that comes into play by Mr. Peabody 
and	further	proves	itself	further	down	the	plot	is	“All	great	relationships	start	with	conflict	and	then	evolves	into	something	
greater”.

Transition from 2D to 3D 
The original Peabody and Sherman started back in 1959 and it had very minimal budget. To keep costs low, not only was the 
show produced in Mexico but the artists used house paint  to paint on cels so that the cels could be erased and reused. Also, 
part	of	the	influencing	style	of	the	original	cartoon	was	that	it	was	created	for	TV,	and	with	the	limited	technology,	the	art	
required to have heavy outlines for things to be visible. The movie sought to approach with the same aesthetic sensibility of 
being	graphic,	designed,	and	flat.	There	was	at	one	point	when	Mr.	Peabody	was	designed	with	square	glasses,	to	make	him	
more modern and trendy and to contrast Sherman’s roundness, but that was quickly veto’d as the round glasses were signature 
of the time back when Peabody and Sherman aired.

Limited animation of original cartoons 
While some may feel that to be true to the original classic cartoons, the same or similar limited animation is required. However, 
the limit was due to the budget and technology back then, not because artists wanted the animation to look exactly that way. 
Back then they had a limited budget so there was limited animation but now with a high budget it would make sense to have 
high animation. In fact, Jay Ward even wanted better animation if it was possible. As a movie about time traveling, in a way 
it	makes	sense	for	them	to	change	for	the	different	time	periods.	Like	looking	in	a	mirror,	the	original	2D	and	the	current	CG	
versions	are	the	same	but	different.

Balance between the adult and children audiences
While there may be some lines to be drawn between adult and children audiences in terms of humor, what Rob, Alex, and 
Denise, sought to do instead is to make the comedy universally funny and able to encompass both age groups. It is not so much 
of	there	is	this,	this,	and	this,	to	do		and	while	there	is	that,	that,	and	that,	to	not	do	but	rather	to	find	what	is	thought	is	funny	
and	hope	that	everyone	else	will	find	it	funny	also.	Rob	has	even	asked	this	same	question	about	comedy	to	Chuck	Jones	before.	
Chuck Jones’ reply back is to find ways to make yourself laugh and others may laugh also.



Bryan Woods - Freelancing in the VFX Industry
April 17th, 2015

Thanks to a speaker event held by Pixelnauts, Bryan Woods gave a talk all about 
freelancing in the animation & vfx industry in what to expect, what it entails, what is 
required of you, and how to survive it.

First to know are the pros and cons of being a freelancer
Pros Cons

Own boss Self employment taxes
Own hours No health care
Own rate No 401K

Exposure to other artists to share ideas & experiences Nagging for payments
Grow as an artist Contracts

Find creative outlet Looking for the next job
If	you	are	fine	with	all	the	above,	then	let’s	continue	on.

Before you Graduate
You’re in school for a reason so don’t be a slacker and make the most out of your education. Get involved in large scale student 
projects to get experience not only working in a pipeline but also in working with other people. Try other classes, don’t 
pigeonhole	yourself	into	doing	a	single	thing.	Maybe	you’ll	find	something	that	you’re	just	as	good	as	or	like	even	more	so	than	
what you initially decided to focus on. That’s how Bryan got into mo-graph from being a compositor.

Your teachers are a great asset and have been in the industry before so make sure to pick their brains for their experiences 
and	knowledge.	Outside	of	school,	try	joining	different	forums	where	you	can	continue	to	learn	and	interact	with	others	in	the	
industry. Some notable ones are CGSociety, JahFx, and FXGuide.

Having	an	every	day	or	every	week	project	is	important	to	get	those	creative	juices	flowing	and	to	keep	yourself	interested	in	
your	work.	Don’t	burn	yourself	out	on	doing	the	same	things	continuously.	You	can	set	yourself	up	to	just	try	out	a	different	tool	
or program to learn each day.

Make sure to have your reel and website ready. Websites have become a dime a dozen now and everybody has one. They are so 
easy to create with various services that there’s no reason not to have a website. Check out SquareSpace, Wix, Wordpress, 



or	Behance	to	get	started.	Also	important	is	to	make	sure	your	LinkedIn	is	filled	out.	Use	LinkedIn	as	a	documentation	of	all	the	
work you have done and achievements that you have received.

Researching	the	industry	is	a	must.	Things	to	look	into	are	salaries	between	different	positions,	what	“entry	level”	really	means	
for	different	companies,	and	where	exactly	you	want	to	work	at.	What	studios	are	there	local?	How	about	in	different	states?	
Abroad?	All	excellent	questions	that	you	need	to	have	answers	to.	A	fantastic	resource	is	comes	from	Coroflot	that	shows	
fantastic	statistics	that	include	the	25th	percentile,	median,	and	75th	percentile	of	different	jobs	in	different	states.

As	a	freelance	artist	you	will	most	likely	be	depending	on	pay	check	to	pay	check	so	make	sure	you	figure	out	your	finances	
ahead of time.

Where to Look for Work
There are 3 ways to be hired. 

Temp	employee	through	staffing	agency	(W2)
Freelancer (1099MISC)
Contractor (personal business)
Temp	employees	through	a	staffing	agency	have	their	taxes	taken	out	of	their	paycheck	automatically.	You	don’t	have	to	report	
to	IRS,	just	file	it	at	the	start	of	the	new	year	when	you	do	your	taxes.	Freelancers	and	contractors,	on	the	other	hand,	must	do	
quarterly payment to the IRS on an estimate of how much they’ll make in a year.

Where to actually look for work would involve forums, local listings (such as Craigslist), instructors, peers, by word of mouth, 
staffing	agencies,	LinkedIn,	or	by	contacting	agencies	directly.

Reels
Everybody says the same so I hope you’ve been listening. If not, here it is again. Keep it short! 1-1.5min is a good time limit. Have 
your	best	work	in	your	reel	and	make	sure	the	best	of	the	best	are	the	first	and	last	things	shown.	The	breakdowns	should	be	
quick	with	minimal	wiping.	Think	you’re	done?	Nope.	Get	it	reviewed!	If	you’re	part	of	a	forum,	upload	it	there	to	be	critiqued	as	
well.

Setting your Rate
The million dollar question of being a freelancer. The best way to calculate your rate is to take all your major expenses (rent, 
utilities, food, 

phone, insurance, website, subscriptions/licenses, etc) and make that in a week. Every week you work, you cover yourself for a 
month. This way you’ll always be able to cover your living expenses and have a little bit of leeway if there is downtime between 
jobs. 

Say your total is $2,130/month.
$2130/5 days = $426/week.
$426/8 hours = $54/hour
If you feel that your rate is too high, especially if you’re freshly out of school and quite haven’t made a name for yourself and 
established your reputation, you can try every two weeks covering yourself for a month. In that case it would be $27/hour.

When calculating taxes, assume a little over a third will be taken out. Multiply your earnings by 0.36 and then subtract from 
total, or multiple by 0.64. That is your adjusted income.

Know	the	difference	between	OverTime	and	DoubleTime	and	when	they	take	effect.
The	first	8	hours	of	work	are	you	standard	rate.	The	next	4	hours	are	considered	OverTime,	which	is	your	rate	+	half.	Anything	
beyond	that	is	considered	DoubleTime,	which	is	double	your	rate.	If	you	exceed	40	hours	in	a	week,	OT	and	DT	take	effect	for	
the	difference	in	the	same	way.

Contracts and Schedule
If you are being hired as a freelancer or contractor, you will need to design a contract and have it approved by the client. Have 
a schedule and an outline of what you will produce, how long each part will take, and when reviews will be. Make sure the 
client	signs	off	on	this	so	you’re	both	accountable.	You	decide	the	frequency	of	reviews,	not	the	other	way	around	as	it	will	be	
detrimental to your work if you’re getting calls every so often from the client wanting status updates. 

That all sounds a little bit daunting but no worries, the Freelancers Union has an awesome website that helps you set up 
contracts to make sure everything is in order and correct.

Last thing about contracts: MAKE SURE YOU READ THEM. Take the time to go through and read all the details, don’t just 
assume and sign away your rights. Be careful of clauses that prohibits you from working for a competitor company as that is 
first,	illegal,	and	second,	is	detrimental	to	yourself	in	finding	jobs.

First Gig / Etiquette
You got that interview and you’re all nervous hoping you get the job. Well here are some tips in how to do just that.



• Speak	confidently.	Talk	up	what	you’re	best	at	and	be	excited	to	talk	about	what	you	like	doing.	You	should	be	talking	the	
most in the interview.

• Don’t mention being fresh out of school. It doesn’t matter. You are at this interview for a reason, and that being they’ve 
seen your work and they like what they see.

• If the topic of money comes up, be direct. “My rate is _____”. That’s it. No more and no less. It is primarily for 
documentation purposes and if the client can’t do it, they’ll let you know and negotiate. You will never be “laughed out of 
the building” for your starting rate; if you are that’s not some place that you want to be anyway

• Always be prepared and that entails having a tablet or laptop with you to show your work and a hard copy of your resume, 
just in case.

• If	you’re	interviewing	for	a	full	time	position,	ask	about	benefits,	taxes,	401k,	and	how	raises	and	promotions	work	within	the	
business.

Aim	for	your	first	gig	to	be	paid.	Don’t	become	known	as	“the	intern”,	as	in	the	person	who	is	willing	to	work	little	to	no	pay.	If	
you get stuck in that people are going to think that they can use you that way forever.

Getting Paid
The best part of having a job!

In an ideal situation the process will be as follows:
Submit	estimate	for	work	>	approval	>	begin	work	>	finish	work	>	send	invoice	>	wait	the	net	30/60	>	money!

Hopefully with good clients and relationships this will be the norm. Unfortunately most times the process gets construed 
through deadline extensions, projects folding, or clients losing their budget. Having a good contract is important as it can 
mitigate most issues. A good contract makes sure to cover extensions, termination, and details when, where, and how 
payments are due. It is also good to address how interest is calculated when you are not paid on time.

Unless you own your own business (which opens up a whole new can of worms) do not have checks written out to your 
business name or portfolio name. The banks will not process them. They have to be written out to you!

Unfortunately when projects fold or when clients lose their budget, their reaction may be to decide not to pay you at all which 
is wrong. You’ve already done at least some of the work and you need to be paid for what you have done. Know when to walk 
away from situations, and when to take things to court. Make sure to research collection agencies in your area and attorneys 
so you have those contacts if things go south. Back to the Freelancer’s Union, they have great articles to help you out in such 
situations.
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